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1. Important

1.	 Important
Ce guide électronique de l’utilisateur est 
conçu pour toutes les personnes qui utilisent 
le moniteur de Philips. Prenez le temps de lire 
ce Manuel d'utilisation avant d’utiliser votre 
moniteur. Il contient des informations et des 
notes importantes au sujet de l'utilisation de 
votre moniteur.

La garantie Philips s'applique à la condition que 
le produit soit manipulé correctement pour 
son utilisation prévue et conformément aux 
instructions d'utilisation, et sur présentation 
de la facture d'origine ou du ticket de caisse 
d'origine, indiquant la date de l'achat, le nom du 
revendeur ainsi que le modèle et le numéro de 
production du produit.

1.1	 Précautions de sécurité et 
d'entretien

	 Avertissements
L’utilisation de touches de réglages, 
d’ajustements ou de procédures différentes 
de celles qui sont décrites dans ce manuel 
pourrait présenter un risque de choc électrique, 
d’électrocution et/ou mécanique.

Lorsque vous connectez et utilisez le moniteur 
de votre ordinateur, lisez et respectez les 
consignes suivantes :

Utilisation

•	 Risque d'électrocution ou d'incendie !

•	 Protégez le moniteur de la lumière directe 
du soleil et ne l'utilisez pas à proximité de 
poêles ou autres sources de chaleur.

•	 Éloignez tout objet pouvant tomber dans 
les orifices de ventilation ou empêcher le 
refroidissement correct des composants 
électroniques du moniteur.

•	 N'obstruez pas les orifices de ventilation 
du boîtier.

•	 Lors de la mise en place du moniteur, 
veillez à ce que la fiche d'alimentation et la 
prise soient facilement accessibles.

•	 Si vous mettez le moniteur hors tension en 
débranchant le câble secteur ou le câble 
d'alimentation CC, attendez 6 secondes 
avant de rebrancher ces câbles.

•	 Utilisez toujours le cordon secteur fourni 
par Philips. Si le cordon secteur est 
manquant, veuillez contacter votre centre 
de service local. (Reportez-vous au chapitre 
« Centre d'information à la clientèle. »)

•	 Ne soumettez pas le moniteur à de fortes 
vibrations ou à des impacts violents lorsque 
vous l’utilisez.

•	 Ne pas heurter ni laisser tomber le 
moniteur pendant l'utilisation ou le 
transport.

Entretien

•	 Afin de protéger votre moniteur contre 
des dommages, n’appuyez pas trop 
fortement sur l’écran. Lorsque vous 
déplacez le moniteur, saisissez-le par 
son cadre pour le soulever ; ne mettez 
assurément pas vos mains ni vos doigts sur 
l'écran pour le soulever.

•	 Débranchez le moniteur si vous envisagez 
de ne pas l'utiliser pendant un certain 
temps.

•	 Débranchez le moniteur si vous voulez le 
nettoyer. Pour ce faire, utilisez un chiffon 
légèrement humide. Vous pouvez aussi vous 
servir d'un chiffon sec, pour autant que 
le moniteur soit hors tension. Par contre, 
n'utilisez jamais de solvants organiques, 
tels que l'alcool ou des liquides à base 
d'ammoniaque, pour nettoyer le moniteur.

•	 Afin d'éviter tout risque d'électrocution ou 
d'endommagement permanent à l'appareil, 
n'exposez pas le moniteur à la poussière ni 
à la pluie.

•	 Ne le mettez pas non plus en contact 
avec de l'eau ni avec un environnement 
excessivement humide.

•	 Si votre moniteur est mouillé par de l'eau, 
essuyez-le aussi rapidement que possible à 
l'aide d'un chiffon sec. Si un corps étranger 
ou de l'eau pénètrent dans le moniteur, 
mettez-le immédiatement hors tension 
et débranchez le cordon secteur. Retirez 
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ensuite le corps étranger ou épongez 
l'eau et envoyez le moniteur au centre de 
maintenance.

•	 Ne pas stocker ni utiliser le moniteur dans 
des endroits tels qu'il risque d'être exposé 
à de la chaleur, à la lumière directe du soleil 
ou à un froid extrême.

•	 Afin d'assurer les performances optimales 
de votre moniteur et l'utiliser pendant 
plus longtemps, il doit se trouver dans 
un endroit compris dans les plages de 
température et d'humidité suivantes :
Température : 0-40°C 32-95°F
Humidité : 20-80% HR

Informations importantes sur les images 
fantômes/résiduelles:

•	 Activez systématiquement un programme 
économiseur d’écran en mouvement 
lorsque votre écran n’est pas sollicité. 
Activez systématiquement une application 
de rafraîchissement périodique de votre 
moniteur pour afficher un contenu 
statique fixe. L'affichage sans interruption 
d'image statique ou immobile sur une 
longue période peut engendrer une « 
rémanence à l’extinction », également 
appelée « image résiduelle » ou « image 
fantôme » sur votre écran. 

•	 Ces images « rémanentes », « en 
surimpression » ou « fantôme » sont un 
phénomène bien connu de la technologie 
des panneaux LCD. Dans la plupart des 
cas, cette « rémanence à l’extinction », ou 
« image résiduelle » ou « image fantôme 
» disparaît progressivement une fois 
l’alimentation éteinte.

	 Avertissement
Ne pas utiliser un économiseur d'écran, ou 
une application de rafraîchissement périodique 
de l'écran, peut entraîner des 'brûlures' 
sévères', ou des 'images résiduelles' ou un effet 
'image fantôme' avec des symptômes qui ne 
disparaissent pas et qui ne peuvent pas être 
réparés. Les dommages mentionnés ci-dessus 
ne sont pas couverts par votre garantie.

Service après-vente :

•	 Le boîtier peut uniquement être ouvert 

par un technicien qualifié.

•	 Si vous avez besoin de documents en 
vue d'une réparation, veuillez prendre 
contact avec votre centre de service local.  
(Reportez-vous au chapitre « Centre 
d'information à la clientèle. »)

•	 Pour plus d’informations sur le transport, 
veuillez vous référer à la section 
« Caractéristiques techniques ».

•	 Ne laissez pas votre moniteur dans une 
voiture ni dans un coffre de voiture à la 
lumière directe du soleil.

	 Remarque
Adressez-vous à un technicien si le moniteur ne 
fonctionne pas normalement ou si vous n'êtes 
pas sûr(e) de la procédure à suivre après avoir 
lu les instructions du mode d'emploi.

1.2	 Notations

Les sous-parties suivantes décrivent les 
différentes conventions de notation utilisées 
dans ce document.

Notes, mises en garde et avertissements

Tout au long de ce guide, des blocs de texte 
pourront être accompagnés d'une icône et 
imprimés en caractères gras ou en italiques. 
Ces blocs contiennent des notes, des mises en 
garde ou des avertissements. Ils sont utilisés de 
la façon suivante:

	 Remarque
Cette icône indique l'existence d'informations 
et de conseils importants vous aidant à mieux 
utiliser votre ordinateur.

	 Mise en garde
Cette icône indique l'existence d'informations 
vous expliquant comment éviter 
l'endommagement potentiel de votre matériel 
ou la perte de données.

	 Avertissement
Cette icône indique qu'il existe un risque de 
blessures et vous explique comment éviter le 
problème.
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Il se peut que des avertissements apparaissent 
sous des formats différents et ne soient pas 
accompagnés d'icônes. Dans ces cas-là, la 
présentation spécifique de l'avertissement 
est dictée par les autorités chargées des 
réglementations.

1.3	 Mise au rebut du produit et des 
matériaux d’emballage

Déchet d'équipement électrique et électro-
nique - DEEE

Cette Marque sur le produit ou sur l’embal-
lage illustre que, sous la Directive Européenne 
2002/96/EC gouvernant l’utilisation des équipe-
ments électriques et électroniques, ce produit 
peut ne pas être jeté avec les ordures ména-
gères. Vous êtes responsable de l'élimination 
de cet équipement à travers une collection aux 
déchets d'équipements électriques et électro-
niques désignés. Afin de déterminer les empla-
cements de telles ordures électriques et élec-
troniques, veuillez contacter votre représentant 
du gouvernement local pour connaitre l’organi-
sation de décharge d’ordure dont dépend votre 
foyer ou le magasin où vous avez acheté le 
produit.

Votre nouveau moniteur contient des maté-
riaux recyclables et réutilisables. Des entreprises 
spécialisées peuvent recycler votre produit pour 
augmenter la quantité de matériels réutilisables 
et minimiser la quantité à être jetée. 

Tous les matériaux d’emballage superflus ont 
été enlevés. Nous avons essayé de notre mieux 
de faciliter la séparation des matériaux d’embal-
lage en des matériaux basiques.

Veuillez consulter votre réglementation locale 
relative à la mise au rebut de votre ancien 

moniteur et des matériaux d’emballage auprès 
de votre revendeur local. 

Informations relative à la reprise/recyclage 
destinées aux clients

Philips établit des objectifs viables d'un point de 
vue technique et économie, visant à optimiser 
les performances environnementales du produit, 
du service et des activités de l'organisation.

Concernant le planning, la conception et les 
étapes de production, Philips se concentre sur 
une fabrication de produits facilement recy-
clables. Chez Philips, la gestion de la fin de vie 
inclut l'implication aux initiatives nationales 
de reprise et aux programmes de recyclage, 
lorsque cela est possible, idéalement en coopé-
ration avec la concurrence, en recyclant tous les 
matériaux (produits et matériaux d'emballage 
correspondants), conformément à l'ensemble 
des lois sur l'environnement et au programme 
de reprise de l'entreprise.  

Votre produit est fabriqué avec des matériaux 
et des composants de haute qualité, qui peuvent 
être recyclés et réutilisés.

Pour en savoir plus sur notre programme de 
recyclage, visitez le site : http://www.philips.com/
sites/philipsglobal/about/sustainability/ourenvi-
ronment/productrecyclingservices.page.
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Connexion à un PC

1.	 Mettez votre ordinateur hors tension et 
débranchez son câble d'alimentation.

2.	 Connectez le câble de signal VGA ou DVI 
ou d'affichage pour la connexion vidéo.

3.	 Connectez le câble audio pour la 
connexion audio.

4.	 Connectez le port USB en amont sur 
le moniteur et le port USB sur votre 
ordinateur avec un câble USB. Le port 
USB en aval est à présent prêt pour 
le branchement de n'importe quel 
périphérique USB.

5.	 Branchez le cordon d'alimentation dans la 
prise de courant proche.

6.	 Mettez votre ordinateur et le moniteur 
sous tension. Si le moniteur affiche une 
image, cela signifie que l'installation est 
terminée.

2.2	 Utilisation du moniteur

	 Description de la vue de face du produit

Pour afficher le menu OSD.

Retourne au niveau précédent 
du menu OSD.

Capteur d'alimentation.

Mise sous tension (ON) et hors 
tension (OFF) du moniteur.

2.	 Installation du moniteur

2.1	 Installation
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Réglage des options du menu 
OSD.

 
Pour ajuster le volume à 
l'affichage.

SmartImage. Vous pouvez choisir 
entre 6 modes différents : 
Office (Bureau), Photo, Movie 
(Film), Game (Jeux), Economy 
(Économie) et Off (Arrêt).

	 Description de l'affichage sur écran

Qu’est-ce que Affichage à l’écran (OSD) ?

La fonction d'affichage des menus à l'écran 
(OSD) est présente avec tous les moniteurs de 
Philips. Elle permet à l'utilisateur final d'effectuer 
des réglages d'écran ou de sélectionner 
directement les fonctions du moniteur par le 
biais d'une fenêtre d'instructions apparaissant 
à l'écran. Une interface conviviale, semblable à 
celle reproduite ci-après, apparaît :












 



Instructions simples et basiques sur les 
touches de contrôle

Dans le menu OSD ci-dessus, l'utilisateur 
peut appuyer sur les touches   situées sur 
le pourtour du moniteur pour déplacer le 
curseur, ou sur OK pour confirmer un choix ou 
effectuer un réglage.

Le menu OSD

Vous trouverez ci-dessous une vue d'ensemble 
de la structure de l'affichage sur écran. Vous 
pourrez par la suite l'utiliser comme référence 

lorsque vous voudrez plus tard revenir aux 
différents réglages.

Main menu Sub menu

Auto

Input
VGA

DVI
DisplayPort

Power Sensor On 0, 1, 2, 3, 4
Off

Audio Stand Alone On, Off

On, OffMute

DP, Audio InDP Audio

Picture
Wide Screen, 4:3

0~100

0~100

On, Off

1.8, 2.0, 2.2, 2.4, 2.6

Picture Format

Brightness

Contrast

SmartContrast

Off, Fast, Faster, FastestSmartResponse

Gamma

On, OffPixel Orbiting

On, OffOver Scan

OSD Settings
0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

Horizontal

Vertical

Transparency

OSD Time out

Setup
0~100

On, Off

Yes, No

0~100

H. Position

V. Position

Resolution Notification

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский  简体中文

Color
5000K, 6500K, 7500K, 8200K, 

9300K, 11500K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temperature

sRGB

User Define

0~100

0~100

Phase

Clock
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	 Avis de résolution

Ce moniteur a été conçu pour fonctionner de 
manière optimale à sa résolution native, qui est 
1920 x 1080@60Hz. Quand le moniteur est 
allumé à une autre résolution, le message d’alerte 
suivant s’affiche à l’écran : Utilisez la résolution 
1920 x 1080@60Hz pour des résultats 
optimaux.

L’affichage du message d’alerte de résolution 
native peut être désactivé à partir de 
Configuration dans le menu d’affichage à l’écran 
(OSD).

	 Fonction physique

Inclinaison

Rotation

-65
65

Faites pivoter

0°

90°

Réglage de la hauteur

110mm
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2.3	 Enlever le support du socle et le 
socle

	 Déposer le socle

Condition :
•	 Pour des montages VESA standard

273P3Q

1.	 Retirez les 4 vis.

2.	 Retirez la base d'écran.

	 Remarque

Ce moniteur utilise une interface de montage 
conforme à VESA de 100mm x 100mm.

100mm

100mm
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3.	 Optimisation de l'image

3.1	 SmartImage

	 De quoi s'agit-il ?

SmartImage propose des préréglages qui vous 
permettent d'optimiser l'affichage de différents 
types de contenu en ajustant dynamiquement la 
luminosité, le contraste, la couleur et la netteté 
en temps réel. Qu'il s'agisse de travaux sur des 
applications de texte, d'affichage d'images ou 
de visualisation d'un clip vidéo, SmartImage 
de Philips vous propose un moniteur avec des 
performances optimisées.

	 Pourquoi en ai-je besoin ?

Vous attendez de votre moniteur un affichage 
optimisé de tous vos types favoris de contenu. 
Le logiciel SmartImage ajuste dynamiquement 
la luminosité, le contraste, la couleur et la 
netteté en temps réel pour une expérience de 
visionnage améliorée avec votre moniteur.

	 Comment ça marche ?

SmartImage est une technologie Philips exclusive 
et de pointe. Elle analyse le contenu affiché 
sur votre écran. En se basant sur un scénario 
choisi, SmartImage optimise dynamiquement 
le contraste, la saturation des couleurs et la 
netteté des images pour des performances 
d'affichage ultimes, le tout en temps réel par la 
simple pression sur un bouton.

	 Comment activer SmartImage ?

1.	 Appuyez sur  pour lancer SmartImage 
sur l'affichage à l'écran.

2.	 Restez appuyé sur  pour passer d'une 
fonction à une autre, Office (Bureau), 
Photo, Movie (Film), Game (Jeux), Economy 
(Économie) et Off (Arrêt).

3.	 Le menu sur écran SmartImage reste 
affiché pendant 5 secondes. Vous pouvez 
également appuyer sur « OK » pour 
confirmer.

4.	 Une fois SmartImage activé, le schéma 
sRVB est automatiquement désactivé. Pour 
utiliser le modèle sRVB, il faut désactiver 
SmartImage en utilisant le bouton  sur le 
panneau avant de votre moniteur.

Outre l'utilisation de la touche  pour le 
défilement vers le bas, vous pouvez également 
appuyer sur les boutons   pour effectuer 
votre choix, puis sur « OK » pour confirmer 
la sélection et fermer le menu à l'écran 
SmartImage.

Vous pouvez choisir entre six modes différents : 
Office (Bureau), Photo, Movie (Film), Game 
(Jeux), Economy (Économie) et Off (Arrêt).





 

 

 

 

              



9

3. Optimisation de l'image

•	 Office (Bureau) :  Optimise le texte et 
adoucit la luminosité pour augmenter la 
lisibilité et réduire la fatigue oculaire. Ce 
mode optimise la lisibilité et la productivité 
de façon significative lorsque vous travaillez 
avec des feuilles de calcul, des fichiers PDF, 
des documents numérisés et d'autres 
applications générales de bureau.

•	 Photo :  Ce profil associe la saturation 
des couleurs, le contraste dynamique 
et l'optimisation de la netteté pour un 
affichage de photos et d'autres images 
incroyablement clair avec des couleurs vives 
- le tout sans effet parasite et sans couleurs 
estompées.

•	 Movie (Film) :  La luminance accentuée, 
la saturation profonde des couleurs, le 
contraste dynamique et la netteté précise 
permettent d'obtenir un affichage de 
chaque détail dans les zones sombres de 
vos clips vidéo, sans décoloration dans les 
zones plus lumineuses, tout en maintenant 
des valeurs dynamiques naturelles pour un 
affichage vidéo optimal.

•	 Game (Jeux) :  Activez le circuit ‘overdrive’ 
pour obtenir un meilleur temps de 
réponse, moins de flou sur les bords avec 
des images qui changent rapidement sur 
l’écran, un meilleur taux de contraste pour 
les scènes claires ou foncées ; ce profil est 
idéal pour les jeux.

•	 Economy (Économie) :  Dans ce 
profil, le réglage de la luminosité et du 
contraste ainsi que la rectification fine du 
rétroéclairage permettent d'obtenir un 
affichage correct pour les applications 
quotidiennes de bureau, tout en diminuant 
la consommation électrique.

•	 Off (Désactivé) :  Pas d'optimisation par 
SmartImage.

3.2	 SmartContrast

	 De quoi s'agit-il ?

Cette technologie unique analyse de façon 
dynamique le contenu à l'écran, et optimise 
automatiquement le contraste du moniteur 
pour une clarté visuelle et un plaisir visuel 
maximum. Le rétroéclairage est ainsi augmenté 
pour des images plus claires, plus précises et 
plus lumineuses, ou diminué pour un affichage 
clair des images sur fond sombre.

	 Pourquoi en ai-je besoin ?

Vous attendez une clarté visuelle optimale 
et un confort visuel, quel que soit le type de 
contenu à l'écran. SmartConstrast contrôle 
dynamiquement le contraste et ajuste le 
rétroéclairage pour des images ou des 
écrans de jeu et de vidéo claires, précises et 
lumineuses, et pour du texte de bureautique 
lisible. En réduisant la consommation électrique 
de votre moniteur, vous réalisez des économies 
énergétiques et prolongez la durée de vie de 
votre écran.

	 Comment ça marche ?

Lorsque vous activez SmartContrast, ce dernier 
va analyser le contenu affiché en temps réel 
et ajuster les couleurs et contrôler l'intensité 
du rétroéclairage. Cette fonction permet 
d'optimiser dynamiquement le contraste 
pour plus de plaisir dans votre divertissement, 
visionnage de clips vidéo ou jeux.
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3.3	 Philips SmartControl Premium

Le nouveau logiciel SmartControl Premium 
de Phillips vous permet de contrôler votre 
moniteur à l’aide d’une interface graphique facile 
à utiliser. C'en est fini des réglages compliqués, 
ce logiciel pratique vous aide à ajuster la 
résolution, à faire l'étalonnage des couleurs, les 
réglages de l’horloge/de la phase, le réglage du 
point blanc RVB, etc.

Grâce aux dernières technologies dans 
l'algorithme principal, offrant un traitement et 
un temps de réponse plus rapides, ce logiciel 
compatible avec Windows 7 est basé sur des 
icônes avec une interface très conviviale pour 
vous aider à bien utiliser vos moniteurs de 
Philips.

	 Installation

•	 Suivez les instructions pour l'installation.

•	 Vous pouvez le lancer une fois l'installation 
terminée.

•	 Si vous voulez lancer le logiciel 
ultérieurement, vous pourrez alors cliquer 
sur le raccourci du bureau ou de la barre 
d'outils.

Premier lancement – Assistant

•	 La première fois après l'installation de 
SmartControl Premium, l'assistant est 
automatiquement lancé.

•	 L'assistant va vous aider à ajuster les 
performances de votre moniteur, étape 
après étape.

•	 Rendez-vous dans le menu Branchement 
pour lancer l'assistant ultérieurement.

•	 Vous pouvez ajuster davantage d'options 
sans l'assistant depuis le panneau Standard.

	 Lancement depuis le panneau Standard :

Adjust menu (Menu Réglage)

•	 Le menu Adjust (Réglage) vous permet 
d'ajuster la Brightness (luminosité), le 
Contrast (contraste), la Focus (mise au 
point), la Position and Resolution (position 
et la résolution).

•	 Suivez les instructions pour effectuer les 
réglages.

•	 L'invite Cancel (Annuler) vous permet 
d'annuler l'installation.
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Color menu (Menu Couleur)

•	 Le menu Color (Couleur) vous permet 
d'ajuster le RGB (rouge/vert/bleu), le 
Black Level (niveau de noir), le White 
Point (point blanc), Color Calibration 
(l'étalonnage des couleurs) et SmartImage 
(veuillez consulter la section SmartImage).

•	 Suivez les instructions pour effectuer les 
réglages.

•	 Référez-vous au tableau ci-dessous pour 
les éléments du sous-menu selon votre 
choix.

•	 Exemple pour Color Calibration 
(l'étalonnage des couleurs).
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1.	 « Show Me » lance le tutoriel d'aide à 
l'étalonnage des couleurs.

2.	 Start (Démarrer) - lance la séquence 
d'étalonnage des couleurs en 6 étapes.

3.	 Quick View (Visualisation rapide) charge les 
images précédente/suivante.

4.	 Pour retourner au panneau d'accueil Color 
(Couleur), cliquez sur le bouton Cancel 
(Annuler).

5.	 Enable color calibration (Active l'étalonnage 
des couleurs) - activé par défaut. Si la case 
n'est pas cochée, il n'y a pas d'étalonnage 
des couleurs, les boutons Démarrer et 
Visualisation rapide sont grisés.

6.	 Les informations relatives au brevet doivent 
figurer sur l'écran d'étalonnage.

Écran de premier étalonnage des couleurs

•	 Le bouton Previous (précédent) est 
désactivé jusqu'au deuxième écran de 
couleur.

•	 Next (Suivant) permet d'accéder à la cible 
suivante (6 cibles).

•	 Enfin allez dans le panneau File>Presets 
(Fichier>Préréglages).

•	 Cancel (Annuler) ferme l'interface 
utilisateur et retourne à la page 
Branchement.
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SmartImage

Permet à l'utilisateur de modifier les réglages 
pour un meilleur affichage selon le contenu.

Lorsque le mode Entertainment 
(Divertissement) est activé, SmartContrast et 
SmartResponse sont également activés.

ECO

Le panneau Système antivol n'est disponible 
que lorsque vous sélectionnez Mode antivol 
dans le menu déroulant Branchements.

Pour activer le système antivol, cliquez sur le 
bouton Activer le mode antivol. L'écran suivant 
s'affiche :

•	 Saisissez un PIN de 4 à 9 chiffres 
seulement.

•	 Une fois le PIN saisi, le fait d'appuyer sur 
le bouton Accept (Accepter) affiche une 
boîte de dialogue sur la page suivante.

•	 Minutes minimum réglé sur 5. Le curseur 
est réglé sur 5 par défaut.

•	 Inutile d'attacher l'écran à un autre 
dispositif pour entrer en mode antivol.
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Après la création du PIN, le panneau Système 
antivol indique Système antivol activé et affiche 
le bouton PIN Options (Options PIN) :

•	 Système antivol activé s'affiche.

•	 Désactiver le Mode antivol ouvre l'écran 
de la page suivante.

•	 Le bouton PIN Options (Options PIN) 
n'est disponible qu'après avoir crée le PIN. 
Ce bouton permet d'accéder au site Web 
de PIN sécurisé.

Options>Preferences (Préférences) - n'est 
disponible que lorsque vous choisissez 
Preferences (Préférences) dans le menu 
déroulant Options. Sur un écran non pris en 
charge, mais compatible DDC/CI, seuls les 
onglets Help (Aide) et Options sont disponibles.

•	 Affiche les réglages préférés actuels.

•	 Cochez la case pour activer la fonction. La 
case à cocher est une touche à bascule.

•	 Activer le menu contextuel sur le bureau 
est coché (activé) par défaut. Activer le 
menu contextuel affiche les sélections 
SmartControl Premium pour Choisir 
préréglage et Tune Display (Régler 
affichage) dans le menu contextuel 
du bureau (clic avec le bouton droit). 
Désactivé supprime SmartControl 
Premium du menu contextuel (clic avec le 
bouton droit).

•	 Activer l'icône barre des tâches est coché 
(activé) par défaut. Activer le menu 
contextuel affiche le menu de la barre 
des tâches pour SmartControl Premium. 
Cliquez avec le bouton droit sur l'icône 
de la barre des tâches pour afficher 
les options du menu pour Help (Aide), 
Technical Support (Assistance technique), 
Check for Upgrade (Vérification des 
mises à niveau), About (À propos) et 
Exit (Quitter). Lorsque le menu Activer 
barre des tâches est désactivé, l'icône de 
la barre des tâches n'affiche que EXIT 
(QUITTER).

•	 Run at Startup (Exécution au démarrage) 
est coché (activé) par défaut. En cas de 
désactivation, SmartControl Premium 
n'est pas lancé au démarrage ou reste 
dans la barre des tâches. Pour lancer 
SmartControl Premium, utilisez le 
raccourci depuis le bureau ou la liste des 
programmes. Si cette case est décochée 
(désactivée), aucun préréglage ne se 
charge au démarrage, même s'il a été 
défini comme devant s'exécuter au 
démarrage.

•	 Activer le Mode transparence (Windows 
7, Vista, XP). Par défaut : 0% opaque.
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Options>Input (Entrée) - n'est disponible que 
lorsque vous choisissez Input (Entrée) dans le 
menu déroulant Options. Sur un écran non pris 
en charge, mais compatible DDC/CI, seuls les 
onglets Help (Aide) et Options sont disponibles. 
Aucun autre onglet de SmartControl Premium 
n'est disponible.

•	 Affiche le panneau d'instructions Source 
et le paramétrage actuel de la source 
d'entrée.

•	 En mode affichage d'entrée simple, ce 
panneau n'est pas visible.

Options>Audio - n'est disponible que lorsque 
vous choisissez Audio dans le menu déroulant 
Options.

Sur un écran non pris en charge, mais 
compatible DDC/CI, seuls les onglets Help 
(Aide) et Options sont disponibles.

Option>Auto Pivot (Pivot automatique)
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Help>User Manual (Aide>Manuel d'utilisation) 
- n'est disponible que lorsque vous choisissez 
User Manual (Manuel d'utilisation) dans le menu 
déroulant Help (Aide). Sur un écran non pris 
en charge, mais compatible DDC/CI, seuls les 
onglets Help (Aide) et Options sont disponibles.

Help (Aide)>Version - n'est disponible que 
lorsque vous choisissez Version dans le menu 
déroulant Help (Aide). Sur un écran non pris 
en charge, mais compatible DDC/CI, seuls les 
onglets Help (Aide) et Options sont disponibles.

Menu sensible au contexte

Le menu sensible au contexte est Activé 
par défaut. Si Activer le menu contextuel est 
coché dans le panneau Options>Preferences 
(Préférences), le menu est alors visible.

Le menu contextuel présente quatre entrées :

•	 SmartControl Premium - si sélectionné, 
l'écran About (À propos) s'affiche.

•	 Select Preset (Choisir préréglage) - 
présente un menu hiérarchique des 
préréglages enregistrés pour une 
utilisation immédiate. La marque « coché 
» indique le préréglage actuellement 
sélectionné. Il est également possible de 
choisir le Préréglage usine depuis le menu 
déroulant.

•	 Tune Display (Régler affichage) - ouvre 
le panneau de commande SmartControl 
Premium.

•	 SmartImage – Vérifie les réglages 
existants, Office (Bureau), Photo, Movie 
(Film), Game (Jeux), Economy (Économie) 
et Off (Arrêt).

Menu Barre des tâches activé

Le menu barre des tâches s'affiche en cliquant 
avec le bouton droit sur l'icône SmartControl 
Premium, depuis la barre des tâches. Cliquez 
avec le bouton gauche pour lancer l'application.
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La barre des tâches présente cinq entrées :

•	 Help (Aide) - accès au fichier du manuel 
d'utilisation : Ouvre le fichier du manuel 
d'utilisation en utilisant la fenêtre du 
navigateur par défaut.

•	 Technical Support (Assistance technique) 
- affiche la page de l'assistance technique.

•	 Check for Update (Contrôler les mises 
à jour) - accès à la page de renvoi PDI 
et contrôle la version de l'utilisateur par 
rapport à la dernière version disponible.

•	 About (À propos) - affiche les 
informations détaillées de référence : 
version du produit, informations sur la 
publication et nom du produit.

•	 Exit (Quitter) - Ferme SmartControl 
Premium.

Pour exécuter SmartControl Premium une 
nouvelle fois, sélectionnez SmartControl 
Premium dans le menu Programmes, 
double-cliquez sur l'icône PC de bureau ou 
redémarrez le système.

Menu Barre des tâches désactivé

Lorsque la Barre des tâches est désactivée 
dans le dossier des préférences, seul le 
choix EXIT (QUITTER) est disponible. Pour 
supprimer complètement SmartControl 
Premium de la barre des tâches, désactivez 
Run at Startup (Exécuter au démarrage) sous 
Options>Preferences (Préférences).

3.4	 Guide SmartDesktop

	 SmartDesktop

SmartDesktop est dans SmartControl Premium. 
Installez SmartControl Premium et choisissez 
SmartDesktop dans les Options.

•	 Align to partition check box (La case à 
cocher Aligner) sur la partition permet 
l’alignement automatique de la fenêtre 
lorsqu'elle est glissée dans la partition 
définie.

•	 Sélectionnez la partition souhaitée en 
cliquant sur l'icône. La partition sera 
appliquée sur le bureau et l'icône sera en 
surbrillance.

•	 Identify (Identifier) offre un moyen rapide 
pour afficher la grille.
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	 Glisser-et déposer des fenêtres

Une fois les partitions configurés et Aligner 
sur la partition sélectionnée, une fenêtre 
peut être glissée dans la zone et elle sera 
automatiquement alignée. Lorsque la fenêtre et 
le curseur de la souris sont dans la zone, la zone 
passe en surbrillance.

	 Remarque

Si le contour de la zone n'est pas visible lorsque 
vous faites glisser la fenêtre, « Afficher le 
contenu des fenêtres pendant leur déplacement 
» est désactivé. Pour activer :

1.	 Control Panel (Dans le Panneau) de 
configuration, cliquez sur System (Système).

2.	 Cliquez sur Advanced system settings 
(Paramètres système avancés) (pour Vista 
& Win7 OS, il se trouve dans le volet de 
gauche)

3.	 Dans la section Performances, cliquez sur 
Performance (Paramètres).

4.	 Dans la boîte, cochez Show window 
contents (Afficher le contenu) des fenêtres 
pendant leur déplacement, et cliquez sur 
OK.

Autre chemin alternatif :

Vista:

Control Panel (Panneau de configuration) > 
Personalization (Personnalisation) > Window 
Color and Appearance (Couleur et apparence 
des fenêtres) > Cliquez sur « Open Classic 
appearance properties for more color options 
» (Ouvrir les propriétés d'apparence classique 
pour des options de couleurs supplémentaires) 
> Cliquez sur le bouton « Effects » (Effets) > 
cochez Afficher le contenu des fenêtres pendant 
leur déplacement.

XP :

Display Properties (Propriétés d'affichage) > 
Appearance (Apparence) > Effects... (Effets...) > 
cochez Afficher le contenu des fenêtres pendant 
leur déplacement.

Win 7 :

Aucun autre chemin alternatif disponible.

	 Options de la barre de titre

Partition du bureau est accessible à partir de la 
barre de titre de la fenêtre active. Cela fournit 
un moyen rapide et facile de gérer le bureau 
ainsi que d'envoyer une fenêtre quelconque 
vers une partition sans avoir à glisser-déposer. 
Déplacez le curseur dans la barre titre de la 
fenêtre active pour accéder au menu déroulant.

	 Menu de clic-droit

Cliquez-droit sur l'icône Partition du bureau 
pour afficher le menu déroulant.

•	 Find Windows (Trouver les fenêtres) 
– Dans certains cas, l'utilisateur peut 
avoir envoyé plusieurs fenêtres vers la 
même partition. Find Windows (Trouver 
Windows) affichera toutes les fenêtres 
ouvertes et déplacera la fenêtre choisie en 
premier plan.

•	 Desktop Partition (Partition du bureau) 
– Desktop Partition (Partition du 
bureau) affiche la partition actuellement 
sélectionnée et permet à l'utilisateur 
de basculer rapidement vers l'une 
des partitions présentées dans la liste 
déroulante.



19

3. Optimisation de l'image

	 Remarque
Si plus d'un affichage est connecté, l'utilisateur 
peut choisir l'affichage ciblé pour changer la 
partition. L'icône en surbrillance représente la 
partition active actuelle.

•	 Identify Partition (Identifier la partition) 
– Affiche la grille contour sur le bureau 
pour la partition actuelle.

•	 Align On/Align Off (Aligner activé/
Aligner désactivé) – Active/désactive la 
fonction d'alignement automatique par 
glisser-déplacer.

•	 Exit (Quitter) – Desktop Partition 
(Ferme Partition) du bureau et Display 
Tune (Régler l'affichage). Pour réinitialiser, 
lancer Display Tune (Régler l'affichage) 
depuis le menu Démarrer ou le raccourci 
sur le bureau.

	 Menu de clic-gauche

Cliquez-gauche sur l'icône Partition du bureau 
pour envoyer rapidement la fenêtre active vers 
une partition quelconque sans avoir à glisser-
déplacer. Relâchez la souris pour envoyer la 
fenêtre vers la partition en surbrillance.

	 Clic-droit sur la barre des tâches

La barre des tâches contient également la 
plupart des fonctionnalités prises en charge 
dans la barre de titre (à l'exception de l'envoi 
automatique d'une fenêtre vers une partition).

•	 Find Windows (Trouver les fenêtres) 
– Dans certains cas, l'utilisateur peut 
avoir envoyé plusieurs fenêtres vers la 
même partition. Find Windows (Trouver 
Windows) affichera toutes les fenêtres 
ouvertes et déplacera la fenêtre choisie en 
premier plan.

•	 Desktop Partition (Partition du bureau) –  
Desktop Partition (Partition du bureau) 
affiche la partition actuellement 
sélectionnée et permet à l'utilisateur 
de basculer rapidement vers l'une 
des partitions présentées dans la liste 
déroulante.

•	 Identify Partition (Identifier la partition) – 
Affiche la grille contour sur le bureau pour 
la partition actuelle.

•	 Align On/Align Off (Aligner activé/Aligner 
désactivé) – Active/désactive la fonction 
d'alignement automatique par glisser-
déplacer.



3. Optimisation de l'image

20

	 Définitions des partitions de SmartDesktop

Nom Description Image

Full Desktop  
(Bureau complet)

Applique tous les paramètres à l'ensemble du bureau.

Vertical Évalue la résolution de l'écran et divise l'affichage en deux 
zones verticales de taille égale.

Pour maintenir la configuration verticale 90/270.

Horizontal Évalue la résolution de l'écran et divise l'affichage en deux 
zones horizontales de taille égale.

Pour maintenir la configuration horizontale 90/270.

Vertical Triple  
(Triple vertical)

Évalue la résolution de l'écran et divise l'affichage en trois 
zones verticales de taille égale.

Pour 90 Partition 1 horizontal haut Partition 2 horizontal 
centre Partition 3 horizontal bas.

Pour 270 Partition 3 horizontal haut Partition 2 horizontal 
centre Partition 1 horizontal bas.

Vertical Split Left 
(Vertical fractionné 
gauche)

Évalue la résolution d'écran et divise l'affichage en deux 
zones verticales, le côté gauche est une seule zone, le 
côté droit est divisé en deux zones de taille égale.

Pour 90 Partition 1 en haut Partitions 2&3 en bas.

Pour 270 Partition 1 en bas Partitions 2&3 en haut.

Vertical Split Right 
(Vertical fractionné 
droite)

Évalue la résolution d'écran et divise l'affichage en deux 
zones verticales, le côté gauche est une seule zone, le 
côté droit est divisé en deux zones de taille égale.

Pour 90 Partitions 1&2 en haut Partition 3 en bas.

Pour 270 Partition 3 en haut Partitions 1&2 en bas.
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Nom Description Image

Horizontal Split Top 
(Horizontal fractionné 
haut)

Évalue la résolution d'écran et divise l'affichage en deux 
zones horizontales de taille uniforme, la zone supérieure 
est unique, la zone inférieure est divisée en deux zones 
de taille égale.

For 90 Partition 1 sur le côté droit Vertical Partitions 2&3 
sur le côté gauche Vertical.

For 270 Partition 1 sur le côté gauche Vertical Partitions 
2&3 sur le côté droit Vertical.

Horizontal Split 
Bottom (Horizontal 
fractionné bas)

Évalue la résolution d'écran et divise l'affichage en deux 
zones horizontales de taille uniforme, la zone inférieure 
est unique, la zone supérieure est divisée en deux zones 
de taille égale.

For 90 Partitions 1&2 sur le côté droit Vertical Partition 3 
sur le côté gauche Vertical.

For 270 Partitions 1&2 sur le côté gauche Vertical 
Partition 3 sur le côté droit Vertical.

Even Split 
(Fractionnement égal)

Évalue la résolution de l'écran et divise l'affichage en 
quatre zones de taille égale.
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4.	 Power sensor™

PowerSensor est une technologie respectant l'environnement unique de Philips qui permet à l'utilisateur 
d'économiser jusqu'à 80% de la consommation de la puissance. En conformité avec l'effort du sens et 
de la simplicité de Philips, cette technologie conviviale fait le travail pour vous des sa sortie de la boite 
sans aucune installation de matériel ou de logiciel, et sans l'intervention de l'utilisateur dans le mode 
défaut.

	 Comment ça marche ?

•	 PowerSensor fonctionne sur le principe de transmission et la réception de signaux "infrarouges"  
sans danger en détectant la présence de utilisateur.

•	 Lorsque l'utilisateur se trouve devant l'écran, l'écran fonctionne normalement, avec les réglages 
pré déterminés que l'utilisateur a choisi ex. luminosité, contraste, couleur, etc.

•	 En supposant que l'écran était réglé sur 100% de luminosité par exemple, quand l'utilisateur 
quitte sa chaise et ne se trouve plus devant l'écran, l'écran réduira automatiquement sa 
consommation jusqu'à 80%.

Utilisateur non présent devant l’écran Utilisateur non présent

La consommation électrique comme illustrée ci-dessus sert 
uniquement de référence

	 Réglage

Réglages par défaut

Comme réglages par défaut, (réglage 3), PowerSensor est conçu pour détecter la présence de 
l'utilisateur situé entre 30 et 100 cm de l'affichage et à de cinq degrés à gauche ou à droite de 
l'écran.

Réglages personnalisés

•	 Si vous préférez vous trouver dans une position se situant en dehors des paramètres listés ci-
dessus, choisissez un signal de puissance supérieure pour une efficacité de détection optimale: 
Plus le réglage est élevé, plus la détection du signal sera forte. Pour une efficacité PowerSensor 
maximum et pour une détection correcte, veuillez vous placer directement devant votre écran.

•	 Si vous choisissez de vous placer à plus de 100 cm de l'écran utilisez le signal de détection 
maximum pour des distances allant jusqu'à 120cm. (réglage 4)

•	 Comme les vêtements de couleurs sombres ont tendance à absorber les signaux infrarouges 
même quand l'utilisateur se situe à 100 cm de l'affichage, augmentez la puissance du signal quand 
vous portez du noir ou un autre vêtement sombre.

•	 Vous pouvez retourner au mode par défaut a tout moment (réglage 3)
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Power Sensor            3

ATTENTION

Power Sensor off

	 Comment ajuster les réglages

Si PowerSensor ne fonctionne pas correctement dans ou à l'extérieur de la portée par défaut, voici 
comment améliorer la détection:

•	 Pressez la touche de raccourci  PowerSensor

•	 Vous vous trouverez en position par défaut ‘3’ sur la barre de réglage.

•	 Ajustez la détection de réglage  PowerSensor vers le Réglage 4 puis pressez OK.

•	 Testez le nouveau réglage pour vous assurer que PowerSensor vous détecte correctement dans 
votre position actuelle.

•	 La fonction PowerSensor est conçue pour fonctionner uniquement en mode Paysage (position 
horizontale). Une fois PowerSensor allumé, il s'éteindra automatiquement si l'écran est utilisé en 
mode Portrait (90 degrés/ position verticale); il s'allumera automatiquement si l'écran est remis 
dans sa position Paysage par défaut.

	 Remarque

Le mode PowerSensor choisi manuellement restera opérationnel à moins que et jusqu'à ce qu'il soit 
réajusté ou que le mode défaut soit rappelé. Si vous trouvez que PowerSensor est  excessivement 
sensible au mouvement proche pour une raison quelconque, réglez-le sur une puissance de signal 
inférieure.

Touche de raccourci Capteur de distance Mode paysage/portrait

Mode paysage

Mode portrait
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5.	 Caractéristiques techniques
273P3Q

Image/Affichage
Type de dalle d'écran LCD-AMVA
Rétroéclairage LED
Taille de la dalle 27'' L (68,6 cm)
Proportions 16:9
Taille de pixel 0,31 x 0,31 mm
Luminosité 300 cd/m²
SmartContrast 20.000.000:1
Taux de contraste (typique) 5000:1
Temps de réponse (typique) 12 ms
Temps SmartResponse (typique) 6 ms
Résolution optimale 1920x1080 @ 60Hz
Angle de vue 178° (H) / 178° (V) @ Tx Contraste > 10
Amélioration de l'image SmartImage Premium
Couleurs d’affichage 16,7 M
Fréquence de rafraîchissement 
vertical

56Hz -71Hz

Fréquence horizontale 30kHz - 83kHz
sRVB OUI
Connectivité
Entrée de signal DVI (numérique), VGA (Analogique), Display Port
USB USB 2.0 x 3
Signal d'entrée Synchro séparée, synchro sur vert
Entr/ee.sortie audio Entrée audio PC, sortie écouteur
Caractéristiques pratiques
Fonctions pratiques Smartimage/ , Volume/ , Marche/Arrêt, Capteur/retour,  

Menu (OK)
Langues OSD Anglais, Français, Allemand, Italien, Russe, Espagnol, Chinois 

Simplifié, Portugais
Compatibilité Plug & Play DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux  
Socle
Inclinaison -5 / +20 
Rotation -65/+65 
Réglage de la hauteur 110mm 

Alimentation
Mode Marche 35,8 W (typ), 54 W (max)
Mode marche (Mode Eco) 21,3 W (typ)
Consommation d’énergie
(Méthode de test EnergyStar 
5.0) 

Tension d'entrée 
CA à 100VCA 
+/-5VCA, 50Hz 
+/-3Hz

Tension d'entrée 
CA à 115VCA 
+/-5VCA, 60Hz 
+/-3Hz

Tension d'entrée 
CA à 230VCA 
+/-5VCA, 50Hz 
+/-3Hz
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Fonctionnement normal 
(typique) 

25,5W 25,5W 25,6W

Veille 0,5W 0,5W 0,5W
Éteint 0,3W 0,3W 0,3W
Dissipation thermique* Tension d'entrée 

CA à 100VCA 
+/-5VCA, 50Hz 
+/-3Hz

Tension d'entrée 
CA à 115VCA 
+/-5VCA, 60Hz 
+/-3Hz

Tension d'entrée 
CA à 230VCA 
+/-5VCA, 50Hz 
+/-3Hz

Fonctionnement normal 87,03 BTU/hr 87,03 BTU/hr 87,37 BTU/hr
Veille 1,71 BTU/hr 1,71 BTU/hr 1,71 BTU/hr
Éteint 1,024 BTU/hr 1,024 BTU/hr 1,024 BTU/hr
Voyant DEL d’alimentation En mode : Blanc, mode En attente/Veille : Blanc (clignote)

Alimentation Intégré, 100-240VCA, 50/60Hz

Dimensions
Produit avec socle (LxHxP) 642 x 528 x 244 mm
Produit sans socle (LxHxP) 642 x 391 x 65 mm
Poids
Produit avec socle 7,65 kg
Produit sans socle 5,25 kg
Produit emballé 10,79 kg

Condition de fonctionnement
Plage de température  
(en fonctionnement) 

de 0°C à 40°C

Plage de température  
(hors fonctionnement) 

de -20°C à 60°C

Humidité relative de 20% à 80%
Altitude Utilisation : 3 658 m

Hors fonctionnement : 12 192 m

MTBF 30 000 heures 

Environnement
ROHS OUI
Energy Star 5.0
EPEAT Gold (www.epeat.net)
Emballage 100% recyclable
Substances spécifiques Boîtier 100% sans BFR
Conformité et normes
Approbations réglementaires CE Mark, FCC Class B, GOAST, SEMKO, TCO Edge, UL/cUL, 

TUV Ergo, TUV/GS, BSMI
Boîtier
Couleur Noir/Argent
Finition Texture 
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	 Remarque

1.	 EPEAT Gold ou Silver n'est valide qu'aux 
endroits où Philips a enregistré le produit.
Visitez le site www.epeat.net pour connaître 
l'état de l'enregistrement dans votre pays.

2.	 Ces données sont sujettes à modifications 
sans préavis.
Visitez www.philips.com/support pour 
télécharger la dernière version de la 
brochure.

5.1	 Résolution et modes de 
préréglage

	 Résolution maximale 
1920 x 1080 à 60 Hz (Entrée analogique)
1920 x 1080 à 60 Hz (Entrée numérique)

	 Résolution recommandée
1920 x 1080 à 60 Hz (Entrée numérique)

Fréquence H. 
(KHz)

Résolution Fréquence V. 
(Hz)

35.000 640 x 480 67

31.469 640 x 480  60 

31.469 720 x 400  70 

37.879 800 x 600  60

48.363 1024 x 768  60 

44.772 1280 x 720 60

63.891 1280x1024 60

55.935 1440x900 60

65.290 1680x1050 60

67.500 1920x1080 60

	 Remarque
Veuillez noter que votre moniteur fonctionne 
de façon optimale à sa résolution native de 
1920 x 1080 @60Hz. Pour un affichage optimal, 
veuillez suivre cette recommandation quant à la 
résolution.
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6.	 Gestion de l'énergie
Si vous disposez d'une carte vidéo compatible 
VESA DPM ou d'un logiciel installé sur votre 
PC, le moniteur va automatiquement réduire 
sa consommation électrique lorsqu'il n'est 
pas utilisé. En cas d'activation d'une touche 
du clavier, de manipulation de la souris ou 
de détection d'un autre appareil d'entrée, le 
moniteur va automatiquement « se réveiller ». 
 Le tableau suivant affiche la consommation 
électrique et la signalisation de ladite fonction 
d'économie d'énergie :

Définition de la gestion énergétique

Mode VESA Vidéo H-sync V-sync Énergie utilisée
Couleur du 
voyant DEL

Actif ACTIVÉ Oui Oui < 35,8 W (typ.) Blanc

Veille DÉSACTIVÉ Non Non < 0,5 W (typ.)
Blanc 

(clignote) 

Éteint DÉSACTIVÉ - - < 0,3 W (typ.) DÉSACTIVÉ

La configuration suivante est utilisée pour 
mesurer la consommation électrique de ce 
moniteur.

•	 Résolution native : 1920 x 1080
•	 Contraste : 50%
•	 Luminosité : 300 nits
•	 Température de couleurs : 6500k avec 

motif blanc complet

	 Remarque
Ces données sont sujettes à modifications sans 
préavis.
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7.	 Informations Concernant 
les Réglementations

Lead-free Product

Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

	 This equipment has been tested and found 
to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to 
provide reasonable protection against 
harmful interference in a residential 
installation. This equipment generates, uses 
and can radiate radio frequency energy 
and, if not installed and used in accordance 
with the instructions, may cause harmful 
interference to radio communications. 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures:

•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the 
equipment and receiver.

•	 Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced 
radio/TV technician for help.

	 Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device.

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 
with FCC Logo.

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation.

Commission Federale de la Communication 
(FCC Declaration)

	 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de 
l'article 15 Des règles de la FCC. Ces 
limites sont conçues de façon à fourir 
une protection raisonnable contre les 
interférences nuisibles dans le cadre d'une 
installation résidentielle.
CET appareil produit, utilise et peut 
émettre des hyperfréquences qui, si 
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l'appareil n'est pas installé et utilisé selon 
les consignes données, peuvent causer des 
interférences nuisibles aux communications 
radio.
Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

•	 Réorienter ou déplacer l'antenne de 
réception.

•	 Augmenter la distance entre l'équipement 
et le récepteur.

•	 Brancher l'équipement sur un autre circuit 
que celui utilisé par le récepteur.

•	 Demander l'aide du marchand ou d'un 
technicien chevronné en radio/télévision.

	 Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques.
CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice

The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL:
SØRG VED PLACERINGEN FOR, AT NET-
LEDNINGENS STIK OG STIKKONTAKT ER 
NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS:
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI IRROT-
TAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL:
NÅR DETTE UTSTYRET PLASSERES, MÅ DU 
PASSE PÅ AT KONTAKTENE FOR STØMTIL-
FØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III ¤ 5 Abs. 4 der Röntgenverordnung erfüllt 
sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß. 

1.	 Reparaturen nur durch Fachpersonal 
durchgeführt werden. 

2.	 Nur original-Ersatzteile verwendet werden. 

3.	 Bei Ersatz der Bildröhre nur eine 
bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfo-
hlen, die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder weni-
ger. 

	 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

 环保使用期限 

此标识指期限 ( 十年 ), 电子信息产品中含有
的有毒有害物质或元素在正常使用的条件
下不会发生外泄或突变 , 电子信息产品用户
使用该电子信息产品不会对环境造成严重
污染或对其人身、 财产造成严重损害的期
限．
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8.	 Assistance client et 
Garantie

8.1	 Politique de Philips relative aux 
pixels défectueux des écrans plats

Philips s'efforce de livrer des produits de la plus 
haute qualité. Nous utilisons les processus de 
fabrication les plus avancés de l'industrie et les 
méthodes les plus strictes de contrôle de la 
qualité. Néanmoins, des défauts au niveau des 
pixels ou des sous-pixels sont parfois inévitables 
dans les dalles TFT utilisées dans les écrans plats. 
Aucun fabricant ne peut garantir que tous les 
panneaux seront sans pixel défectueux, mais 
Philips garantit que tout moniteur avec un 
nombre inacceptable de défauts sera réparé 
ou remplacé sous garantie. Cet avis explique 
les différents types de défauts de pixels et 
définit les niveaux de défauts acceptables pour 
chacun des ces types. Pour bénéficier de la 
réparation ou du remplacement sous garantie, 
le nombre de défauts de pixels sur un panneau 
TFT doit dépasser ces niveaux acceptables. Par 
exemple, pas plus de 0,0004% des sous-pixels 
d'un moniteur ne peuvent être défectueux. 
En outre, étant donné que certains types ou 
combinaisons de défauts de pixels sont plus 
remarqués que d'autres, Philips détermine des 
niveaux de qualité encore plus élevés. Cette 
garantie est valable dans le monde entier.

Pixels et sous-pixels

Un pixel, ou élément d'image, est composé de 
trois sous-pixels correspondants aux couleurs 
primaires rouge, vert et bleu. Une image se 
compose d'un grand nombre de pixels. Quand 
tous les sous-pixels d'un pixel sont allumés, les 
trois sous-pixels colorés apparaissent ensemble 
comme un seul pixel blanc. Quand ils sont tous 
éteints, les trois sous-pixels colorés apparaissent 

ensemble comme un seul pixel noir. Les autres 
combinaisons de sous-pixels allumés et éteints 
apparaissent comme les pixels individuels 
d'autres couleurs.

Types de défauts de pixels

Les défauts de pixels et de sous-pixels 
apparaissent sur l'écran de différentes façons. Il 
existe deux catégories de défauts de pixels et 
plusieurs types de défauts de sous-pixels dans 
chaque catégorie.

Défauts de points brillants

Les points défectueux brillants sont des pixels 
ou sous-pixels toujours allumés ou 'activés'. Un 
pixel brillant est donc un sous-pixel qui ressort 
du fond sombre de l'écran. Voici les types de 
pixels brillants défectueux.

Un sous-pixel rouge, vert ou bleu allumé.

Deux sous-pixels allumés adjacents :

-	 Rouge + Bleu = Violet
-	 Rouge + Vert = Jaune
-	 Vert + Bleu = Cyan (Bleu pâle)
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Trois sous-pixels adjacents allumés (un pixel 
blanc).

	 Remarque

Un pixel brillant rouge ou bleu a une luminosité 
supérieure à 50 % par rapport aux pixels 
environnants, tandis qu'un pixel brillant vert est 
30 % plus lumineux que les pixels environnants.

Défauts de points sombres

Les points défectueux sombres sont des pixels 
ou sous-pixels toujours noirs ou éteints. Un 
pixel sombre est donc un sous-pixel qui ressort 
du fond clair de l'écran. Voici les types de pixels 
sombres défectueux.

Proximité des défauts de pixels

Du fait que des défauts de même type 
provenant de pixels et sous-pixels proches les 
uns des autres peuvent être plus facilement 
remarqués, Philips spécifie aussi des tolérances 
pour la proximité des défauts de pixels.

Tolérances des défauts de pixels

Pour bénéficier, pendant la période de garantie, 
d'une réparation ou d'un remplacement en 
raison de défauts de pixels, le panneau TFT d'un 
écran plat Philips doit avoir des défauts de pixels 
et sous-pixels qui dépassent les tolérances 
répertoriées dans les tableaux suivants.

DÉFAUTS DES POINTS LUMINEUX NIVEAU ACCEPTABLE 
1 sous-pixel éclairé 3
2 sous-pixels adjacents éclairés 1
3 sous-pixels adjacents éclairés (un pixel blanc) 0
Distance entre deux points lumineux défectueux* >15mm
Total des points lumineux défectueux, tous types confondus 3

POINTS NOIRS DÉFECTUEUX NIVEAU ACCEPTABLE 
1 sous-pixel noir 5 ou moins
2 sous-pixels noirs adjacents 2 ou moins
3 sous-pixels noirs adjacents 0
Distance entre deux points noirs défectueux* >15mm
Nombre total de points défectueux de tous types 5 ou moins

TOTAL DES POINTS DÉFECTUEUX NIVEAU ACCEPTABLE 
Nombre total de points lumineux ou noirs défectueux de tous 
types

5 ou moins

	 Remarque

1.	 1 ou 2 sous-pixels adjacents = 1 point défectueux

2.	 Ce moniteur est conforme à la norme ISO9241-307 (ISO9241-307: méthodes de test sur 
l'exigence ergonomique, l'analyse et la conformité des écrans électroniques)
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8.2	 Assistance client & Garantie
Pour plus d'informations sur la garantie et le support additionnel pour votre région, veuillez consultez le 
site www.philips.com/support. Vous pouvez également contacter le service d'assistance à la clientèle de 
Philips de votre région, à l'un des numéros ci-dessous.

Informations  de  contact  pour  la  région  EUROPE  DE  L'EST  :

Pays ASC Numéro clientèle Prix

Allemagne Siemens I&S +49 01803 386 853 € 0,09

Royaume-Uni Invec Scotland +44 0207 949 0069 Tarif d’appel local

Irlande Invec Scotland +353 01 601 1161 Tarif d’appel local

Espagne Eatsa Spain +34 902 888 785 € 0,10

Finlande A-novo +358 09 2290 1908 Tarif d’appel local

France A-novo +33 082161 1658 € 0,09

Grèce Allman Hellas +30 00800 3122 1223 Gratuit

Italie A-novo +39 840 320 041 € 0,08

Pays-Bas E Care +31 0900 0400 063 € 0,10

Danemark A-novo +45 3525 8761 Tarif d’appel local

Norvège A-novo +47 2270 8250 Tarif d’appel local

Suède A-novo +46 08 632 0016 Tarif d’appel local

Pologne Zolter +48 0223491505 Tarif d’appel local

Autriche Siemens I&S +43 0810 000206 € 0,07

Belgique E Care +32 078 250851 € 0,06

Luxembourg E Care +352 26 84 30 00 Tarif d’appel local

Portugal Eatsa Spain +351 2 1359 1440 Tarif d’appel local

Suisse A-novo +41 02 2310 2116 Tarif d’appel local
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Informations de contact pour la région EUROPE CENTRAL ET EUROPE DE L'EST :

Pays
Centre 
d'appel ASC Numéro clientèle

BIÉLORUSSIE Sans objet IBA +375 17 217 3386

BULGARIE Sans objet LAN Service +359 2 960 2360

CROATIE Sans objet Renoprom +385 1 333 0974

ESTONIE Sans objet FUJITSU +372 6519900

LETTONIE Sans objet «Ser viceNet LV» Ltd. +371 7460399

LITUANIE Sans objet UAB «Ser vicenet» +370 7400088

ROUMANIE Sans objet Blue Ridge Intl. +40 21 2101969

SERBIE ET 
MONTÉNÉGRO

Sans objet Kim Tec d.o.o. +381 11 20 70 684

SLOVÉNIE Sans objet PC H. et +386 1 530 08 24

UKRAINE
Sans objet Comel +380 562320045 

Sans objet Topaz-Service Company +38 044 245 73 31

Russie

Sans objet CPS 
+7 (495) 645 6746  
(pour toute réparation)

Sans objet CEEE Partners
+7 (495) 645 3010  
(pour les ventes)

Slovaquie Sans objet Datalan Service +421 2 49207155

Turquie Sans objet Techpro +90 212 444 4 832 

République tchèque Sans objet Asupport 800 100 697

Hongrie
Sans objet Serware +36 1 2426331 

Sans objet Profi Service +36 1 814 8080

Informations de contact pour la région AMÉRIQUE LATINE :

Pays Centre d'appel Numéro clientèle

Brésil
Vermont 

0800-7254-101

Argentine 0800-3330-856

Informations de contact pour la Chine :

Chine
Numéro clientèle : 4008 800 008

Informations de contact pour l'AMÉRIQUE DU NORD :

Pays Centre d'appel ASC Numéro clientèle

Etats-Unis TOS Teleplan (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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Informations de contact pour la région Asie-Pacifique/Moyen Orient/Afrique :

Pays Centre d'appel ASC Numéro clientèle

Australie Sans objet AGOS NETWORK PTY LTD 1300-360-386

Nouvelle Zélande Sans objet Visual Group Ltd. 0800-657-447

Hong Kong/
Macao

Sans objet Smart Pixels Technology Ltd.
Hong Kong : Tél. : +852 2619 9639
Macau : Tél. : (853)-0800-987

Inde Sans objet REDINGTON INDIA LTD
Tél. : 1 800 425 6396
SMS: PHILIPS à 56677 

Indonésie Sans objet
PT. Gadingsari elektronika 
Prima

Tél. : 62 21 75909053, 75909056, 
7511530

Corée du sud Sans objet PCS One Korea Ltd. 080-600-6600

Malaisie Sans objet
After Market Solutions (CE) 
Sdn Bhd

603 7953 3370

Pakistan Sans objet Service client Philips (9221) 2737411-16

Singapour Sans objet
Philips Electronics Singapore 
Pte Ltd (Centre client Philips) 

(65) 6882 3999

Taïwan
PCCW 
Teleservices 
Taiwan 

FETEC.CO 0800-231-099

Thaïlande Sans objet
Axis Computer System Co., 
Ltd.

(662) 934-5498

Afrique du Sud Sans objet Sylvara Technologies Pty Ltd 086 0000 888 

ÉMIRATS 
ARABES UNIS

Sans objet
AL SHAHD COMPUTER 
L.L.C 

00971 4 2276525

Israël Sans objet Eastronics LTD 1-800-567000

Vietnam Sans objet
FPT Service Informatic 
Company Ltd.

+84 8 38248007 Ho Chi Minh City
+84 5113.562666 Danang City
+84 5113.562666 Can tho Province

Philippines Sans objet Glee Electronics, Inc.
(02) 633-4533 à 34,
(02) 637-6559 à 60

Sri Lanka Sans objet
à ce jour, aucun distributeur 
et/ou prestataire de service 

Bangladesh Sans objet
Distributeur : Computer 
Source Ltd (rachat de 
garantie)

880-2-9141747, 9127592
880-2-8128848 / 52

Népal Sans objet
Distributeur : Syakar Co. Ltd 
(rachat de garantie)

977-1-4222395 

Cambodge Sans objet
Distributeur : Neat Technology 
Pte Ltd (Singapour) (rachat 
de garantie)

855-023-999992



37

9. Guide de dépannage et Foire Aux Questions

9.	 Guide de dépannage et 
Foire Aux Questions

9.1	 Recherches de causes de pannes

Cette page reprend les problèmes pouvant 
être corrigés par un utilisateur. Si le problème 
persiste même après avoir appliqué ces 
corrections, contactez un représentant du 
service client Philips.

	 Problèmes les plus fréquents

Aucune image (le voyant DEL d’alimentation 
ne s'allume pas.)

•	 Assurez-vous d'avoir bien branché le 
cordon d'alimentation dans une prise, et à 
l'arrière du moniteur.

•	 Puis contrôlez le bouton marche/arrêt à 
l'avant du moniteur. S'il est en position OFF 
(éteint), appuyez pour le mettre en position 
ON (allumé).

Aucune image (Le voyant DEL d’alimentation 
est blanc.)

•	 Vérifiez que l'ordinateur est allumé.

•	 Vérifiez que le câble signal est bien branché 
sur votre ordinateur.

•	 Assurez-vous que le câble du moniteur ne 
présente pas de broches tordues du côté 
connexion. Si c'est le cas, il faut réparer ou 
remplacer le câble.

•	 La fonction d'économie d'énergie est peut-
être activée.

L'écran affiche

Attention

Check cable connection

•	 Vérifiez que le câble du moniteur est bien 
relié à votre ordinateur. (Veuillez également 
vous référer au Guide de démarrage 
rapide).

•	 Vérifiez l'absence de broches tordues au 
niveau du câble du moniteur.

•	 Vérifiez que l'ordinateur est allumé.

Le bouton AUTO ne marche pas.

•	 La fonction auto ne marche qu'en mode 
VGA-Analogique. Si les résultats ne sont 
pas bons, vous pouvez faire un ajustement 
manuel avec le menu OSD.

	 Remarque
La fonction Auto ne marche pas dans le mode 
DVI-Numérique car elle est inutile dans ce 
mode.

Signes visibles de fumée ou d'étincelles.

•	 N'effectuez aucun dépannage.

•	 Débranchez immédiatement le moniteur 
de la prise d’alimentation principale pour 
votre sécurité.

•	 Contactez immédiatement le service-client 
de Philips.

	 Problèmes relatifs à l'image

L'image n'est pas centrée.

•	 Réglez la position de l'image en utilisant la 
fonction « Auto » dans le menu OSD.

•	 Réglez la position de l'image en utilisant 
la fonction Phase/Clock (Horloge) 
d'installation dans les commandes 
principales du menu à l'écran. Elle ne 
fonctionne qu'en mode VGA.

L'image vibre sur l'écran.

•	 Contrôlez le branchement du câble signal 
au niveau de la carte graphique ou du PC.

Un scintillement vertical apparait.

•	 Réglez l'image en utilisant la fonction « 
Auto » dans le menu OSD.
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•	 Éliminez les barres verticales en utilisant la 
fonction Phase/Horloge d'installation dans 
les commandes principales du menu à 
l'écran. Elle ne fonctionne qu'en mode VGA.

Un scintillement horizontal apparait.

•	 Réglez l'image en utilisant la fonction « 
Auto » dans le menu OSD.

•	 Éliminez les barres verticales en utilisant la 
fonction Phase/Horloge d'installation dans 
les commandes principales du menu à 
l'écran. Elle ne fonctionne qu'en mode VGA.

l'image apparaît floue, imparfaite ou trop 
sombre.

•	 Réglez le contraste et la luminosité en 
utilisant le menu à l'écran.

Une image rémanente, en surimpression ou 
image fantôme apparaît lorsque l'alimentation 
est coupée.

•	 L'affichage sans interruption d'image 
statique ou immobile sur une longue 
période peut engendrer une « rémanence 
à l’extinction », également appelée « image 
résiduelle » ou « image fantôme » sur 
votre écran. Ces images « rémanentes », « 
en surimpression » ou « fantôme » sont un 
phénomène bien connu de la technologie 
des panneaux LCD. Dans la plupart des 
cas, cette « rémanence à l’extinction », ou 
« image résiduelle » ou « image fantôme 
» disparaît progressivement une fois 
l’alimentation éteinte.

•	 Activez systématiquement un programme 
économiseur d’écran en mouvement 
lorsque votre écran n’est pas sollicité.

•	 Activez systématiquement une application 
de rafraîchissement périodique de votre 
moniteur pour afficher un contenu statique 
fixe.

•	 Ne pas utiliser un économiseur d'écran, 
ou une application de rafraîchissement 

périodique de l'écran, peut entraîner 
des 'brûlures' sévères', ou des 'images 
résiduelles' ou un effet 'image fantôme' 
avec des symptômes qui ne disparaissent 
pas et qui ne peuvent pas être réparés. Les 
dommages mentionnés ci-dessus ne sont 
pas couverts par votre garantie.

L'image apparaît déformée. Le texte est flou 
ou brouillé.

•	 Réglez la résolution d'affichage du PC sur 
celle recommandée pour le moniteur.

Des points verts, rouges, bleus, sombres et 
blancs apparaissent à l'écran.

•	 Les points rémanents sont une 
caractéristique normale du cristal liquide 
utilisé dans la technologie d'aujourd'hui ; 
veuillez lire la section relative aux pixels 
défectueux pour plus de détails.

Le voyant « Marche » est trop puissant et me 
gêne.

•	 Vous pouvez ajuster le voyant  
« Marche » en utilisant Configuration DEL 
d’alimentation dans le menu OSD.

Pour une assistance plus approfondie, veuillez 
consulter la liste des Centres d'information aux 
clients et contacter un représentant du service 
client Philips.
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9.2	 Questions fréquentes - 
SmartControl Premium

Q1.	 J'ai remplacé le moniteur de mon 
PC par un nouveau moniteur et 
SmartControl Premium ne marche 
plus. Que faire ?

Rép.:	 Rallumez votre PC et vérifiez si 
SmartControl Premium marche 
correctement. Si ce n'est pas le cas, 
vous devrez supprimer puis réinstaller 
SmartControl Premium pour garantir la 
bonne installation du pilote.

Q2.	 Les fonctions de SmartControl 
Premium marchaient correctement 
avant mais ne marchent plus 
maintenant. Que faire ?

Rép.:	 Commencez par effectuer les actions 
suivantes. Si cela ne fonctionne pas, il 
faut peut-être réinstaller le pilote du 
moniteur.

•	 Remplacez la carte graphique par une 
autre

•	 Mettez à jour le pilote vidéo

•	 Activités sur le système d'exploitation, telles 
que service pack ou patch

•	 Exécutez la mise à jour de Windows ainsi 
que le pilote du moniteur et/ou vidéo mis 
à jour

•	 Windows a été redémarré alors que le 
moniteur était hors tension ou déconnecté.

•	 Pour résoudre le problème, cliquez avec le 
bouton droit sur Poste de travail, puis sur 
Propriétés-> Matériel-> Gestionnaire de 
périphériques.

•	  Si la mention « Moniteur Plug-and-Play » 
accompagne l'icône du moniteur, il vous 
faudra procéder à une nouvelle installation. 
Désinstallez simplement SmartControl 
Premium et réinstallez-le.

Q3.	 Après avoir installé SmartControl 
Premium, lorsque je clique sur l'onglet 
SmartControl Premium, rien ne se 

passe ou un message d'erreur apparaît. 
Que s'est-il passé ?

Rép.:	 Il se peut que votre carte graphique ne 
soit pas compatible avec SmartControl 
Premium. Si votre carte graphique fait 
partie des marques susmentionnées, 
essayez de télécharger le pilote de la 
carte graphique le plus récent depuis 
le site Internet correspondant à ladite 
marque. Installez le pilote. Désinstallez 
SmartControl Premium, et réinstallez-le 
à nouveau.
Si cela ne fonctionne toujours pas, c'est 
que la carte graphique n'est pas prise 
en charge. Veuillez visiter le site Web 
de Philips pour vérifier si une nouvelle 
version du pilote de SmartControl 
Premium est disponible.

Q4.	 Lorsque je clique sur Informations 
produit, toutes les informations 
n'apparaissent pas. Pourquoi ?

Rép.:	 Le pilote de votre carte graphique 
n'est peut-être pas la toute dernière 
version disponible et ne prend donc 
pas totalement en charge l'interface 
DDC/CI. Essayez de télécharger la toute 
dernière version du pilote de la carte 
graphique depuis le site Internet de la 
marque de la carte. Installez le pilote. 
Désinstallez SmartControl Premium et 
réinstallez-le à nouveau.

Attention

Theft mode enabled

Q5.	 J'ai égaré mon code PIN pour la 
fonction Système antivol. Que faire ?

Rép.:	 Le service client de Philips a le droit 
de vous demander une preuve 
d’identification et d’autorisation, pour 
vérifier si vous êtes le propriétaire légal 
du moniteur.
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9.3	 Questions générales

Q1:	 Lorsque j'installe mon moniteur, que 
faire lorsque l'écran affiche Cannot 
display this video mode « Impossible 
d'afficher ce mode vidéo » ?

Rép.:	 Résolution recommandée pour ce 
moniteur : 1920 x 1080 @ 60Hz.

•	 Débranchez tous les câbles, puis branchez 
votre PC sur le moniteur que vous utilisiez 
précédemment.

•	 Dans le menu Settings Démarrer 
de Windows, choisissez Settings 
(Paramètres)/Control Panel (Panneau de 
configuration). Dans la fenêtre du Panneau 
de configuration, sélectionnez l'icône 
Display (Affichage). Dans le panneau de 
configuration Affichage, sélectionnez l'onglet 
'Settings' « Paramètres ». Dans l'onglet 
Paramètres, dans la boîte desktop area 
(zone bureau), déplacez la réglette sur 
1920 x 1080 pixels.

•	 Ouvrez les 'Advanced Properties' 
« Propriétés avancées » et réglez le Taux 
de rafraîchissement sur 60 Hz. Cliquez 
ensuite sur OK.

•	 Redémarrez votre ordinateur, reprenez les 
étapes 2 et 3 et vérifiez que votre PC est 
bien réglé sur 1920 x 1080 @60Hz.

•	 Éteignez votre ordinateur. Débranchez 
votre ancien moniteur puis reconnectez 
votre moniteur Philips.

•	 Mettez votre moniteur sous tension, puis 
allumez votre PC.

Q2:	 Quel est le taux de rafraîchissement 
recommandé pour le moniteur ?

Rép.:	 Le taux de rafraîchissement 
recommandé pour les moniteurs est 
de 60Hz. En cas de perturbation au 
niveau de l'écran, vous pouvez l'ajuster 
sur 75Hz pour tenter de supprimer le 
brouillage.

Q3:	 À quoi servent les fichiers .inf et .icm 
sur le CD-ROM? Comment installer 
les pilotes (.inf et .icm) ?

Rép.:	 Il s'agit des fichiers correspondant au 

pilote de votre moniteur. Suivez les 
instructions de votre manuel d'utilisateur 
pour installer les pilotes. Au moment 
de l'installation de votre moniteur, 
votre ordinateur peut vous demander 
les pilotes du moniteur (les fichiers 
.inf et .icm) ou un disque contenant 
les pilotes. Suivez les instructions pour 
insérer le CD-ROM inclus dans cet 
emballage. Les pilotes du moniteur (les 
fichiers .inf et .icm) peuvent s'installer 
automatiquement.

Q4: 	 Comment ajuster la résolution ?

Rép.:	 Le pilote de votre carte graphique et 
le moniteur déterminent ensemble les 
résolutions disponibles. Vous pouvez 
choisir la résolution voulue depuis le 
Panneau de configuration de Windows®, 
sous Display properties « Propriétés 
d'affichage ».

Q5:	 Que faire si je m'embrouille pendant 
les réglages du moniteur ?

Rép.:	 Appuyez simplement sur le bouton OK, 
puis sélectionnez « Réinitialiser » pour 
restaurer tous les paramètres d'origine.

Q6:	 L'écran LCD résiste-t-il aux rayures ?

Rép.:	 En général, il est recommandé d'éviter 
de soumettre la surface du panneau 
à un choc excessif et de le protéger 
contre les objets émoussés ou pointus. 
Lorsque vous manipulez le moniteur, 
assurez-vous de ne pas appliquer 
de pression ou de force sur le côté 
panneau. Cela pourrait affecter vos 
conditions de garantie.

Q7:	 Comment nettoyer la surface de 
l'écran LCD ?

Rép.:	 Pour un nettoyage normal, utilisez 
un chiffon propre et doux. Pour un 
nettoyage plus en profondeur, utilisez 
de l'alcool isopropylique. N'utilisez pas 
de solvant, comme l'alcool éthylique, 
l'éthanol, l'acétone, l'hexane, etc.

Q8: 	 Comment modifier le réglage des 
couleurs sur mon moniteur ?

Rép.:	 Vous pouvez modifier le réglage des 
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couleurs depuis la commande du menu 
à l'écran. Suivez la procédure ci-dessous:
•	 Appuyez sur « OK » pour afficher 

le menu OSD (affichage à l’écran).
•	 Appuyez sur la « Flèche vers le 

bas » pour sélectionner l'option « 
Couleur ». Appuyez ensuite sur « 
OK » pour ouvrir le sous-menu de 
réglage des couleurs ; il y a trois 
réglages indiqués ci-dessous :

1.	 Température de couleurs ; les six réglages 
sont  5 000K, 6 500K, 7 500K, 8 200K, 9 
300K et 11 500K. Avec un paramétrage 
dans la plage des 5 000K, l'écran apparaît « 
chaud », avec une tonalité rouge-blanc. La 
température 11 500K est plus « froide », 
avec une tonalité bleu-blanc.

2.	 sRVB ; il s'agit d'un réglage standard 
permettant d'assurer le bon échange des 
couleurs entre différents appareils (par 
exemple les appareils photos numériques, les 
moniteurs, les imprimantes, les scanners, etc.)

3.	 Défini par l'utilisateur ; l'utilisateur peut 
choisir son réglage préféré des couleurs en 
ajustant le rouge, le vert et le bleu.

	 Remarque :
Une mesure de la couleur de la lumière 
émise par un objet lorsqu'il est chauffé. Cette 
mesure s'exprime en termes d'échelle absolue 
(degrés Kelvin). Les températures Kelvin faibles, 
comme 2 004K, sont rouges. Les températures 
plus élevées, comme 9 300K sont bleues. La 
température neutre est blanche, à 6 504K.

Q9: 	 Est-il possible de connecter mon 
moniteur à n'importe quel PC, station 
de travail ou Mac ?

Rép. :	 Oui. Tous les moniteurs Philips sont 
compatibles avec les PC, les Mac et 
les stations de travail standard. Vous 
aurez peut-être besoin d'un adaptateur 
de câble pour brancher le moniteur 
sur un système Mac. Nous vous 
recommandons de contacter votre 
représentant commercial Philips pour 
plus d'informations.

Q10: 	 Les moniteurs Philips disposent-ils de 
la fonctionnalité 'Plug-and-Play' ?

Rép.:	 Oui, les moniteurs sont compatibles 
'Plug-and-Play' avec Windows 7, 98, 
2000, XP, Vista et Linux.

Q11: 	 Qu'appelle-t-on 'image rémanente', 
'image en surimpression', 'image 
résiduelle', ou 'image fantôme' pour les 
écrans ?

Rép.:	 L'affichage sans interruption d'image 
statique ou immobile sur une longue 
période peut engendrer une « 
rémanence à l’extinction », également 
appelée « image résiduelle » ou « image 
fantôme » sur votre écran. Ces images  
« rémanentes », « en surimpression » 
ou « fantôme » sont un phénomène 
bien connu de la technologie des 
panneaux LCD. Dans la plupart des cas, 
cette « rémanence à l’extinction », ou  
« image résiduelle » ou « image 
fantôme » disparaît progressivement 
une fois l’alimentation éteinte.
Activez systématiquement un 
programme économiseur d’écran en 
mouvement lorsque votre écran n’est 
pas sollicité.

Activez systématiquement une 
application de rafraîchissement 
périodique de votre moniteur pour 
afficher un contenu statique fixe.

	 Avertissement
Ne pas utiliser un économiseur d'écran, ou 
une application de rafraîchissement périodique 
de l'écran, peut entraîner des 'brûlures' 
sévères', ou des 'images résiduelles' ou un effet 
'image fantôme' avec des symptômes qui ne 
disparaissent pas et qui ne peuvent pas être 
réparés. Les dommages mentionnés ci-dessus 
ne sont pas couverts par votre garantie.

Q12: 	 Pourquoi mon Affichage ne me permet 
pas d'obtenir un texte clair, le contour 
des caractères affichés n'est pas net.

Rép.:	 Votre moniteur fonctionne de façon 
optimale en utilisant la résolution 1920 
x 1080 @60Hz. Pour un affichage 
optimal, utilisez cette résolution.
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